Trademarks
Microsoft is a U.S. registered trademark of Microsoft Corporation.
Windows, Windows Vista, Windows 7 and Windows 8 are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
IBM, IBM PC are registered trademarks of International Business Machines Corp.
Other brands and product names herein are trademarks or registered trademarks of their respective holders.

Copyright
All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Avision Inc.

Material scanned by this product may be protected by government laws and other regulations such as copyright laws, the customer is solely responsible for complying with all such laws and regulations.

Warranty
The information contained in this document is subject to change without notice.

Avision makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.
FCC Radio Frequency Interference Statement

This product has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. The FCC Class B limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.
European Union Regulatory Notice

Products bearing the CE marking comply with the following EU Directives:

- Low Voltage Directive 2006/95/EC
- EMC Directive 2004/108/EC
- Restriction of the use of certain hazardous substances (RoHS) Directive 2011/65/EU

CE compliance of this product is valid if powered with the correct CE-marked AC adapter provided by Avision.

This product satisfies the Class B limits of EN55022, EN55024, safety requirements of EN 60950 and ROHS requirements of EN50581.

*This product is certified as Class 1 LED product.*
Disposal of Waste Equipment by Users in Private Union

This symbol on the product or on its packaging indicates that the product can not be disposed of with your other household waste. Instead it should be sent to appropriate facilities for recovery and recycling in an effort to protect human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

*This machine is certified as Class 1 LED product. This means that this machine does not produce hazardous laser radiation.

**System Requirements**

- IBM compatible PC 586, Pentium or higher
- Microsoft Windows XP(SP3), Windows Vista/Windows 7/Windows 8
- USB port 2.0 (compatible with USB 1.1)
- At least 100 MB of free hard disk space (500 MB is recommended)
- At least 128 MB of system memory (512 MB of RAM is recommended)
  - At least 1 GB of RAM for Windows Vista or later
- A CD-ROM drive
Table of Contents

1. Introduction .............................................................................. 1-1
   1.1 The Package Contents .................................................. 1-2
   1.2 Knowing the Control Panel ............................................ 1-3

2. Installation ................................................................................. 2-1
   2.1 Connecting to Power .................................................... 2-1
   2.2 Turning on the Power ..................................................... 2-1
   2.3 Installing the Scanner Driver ......................................... 2-2
   2.4 Connecting to a Computer ............................................. 2-4
   2.5 Connecting to a USB Flash Disk ................................... 2-5

3. Completing Your First Scan ....................................................... 3-1
   3.1 Placing Your document on the Document Glass .............. 3-1
   3.2 Starting Instant Scan and Saving Your Images to a USB Flash Disk ..................................................... 3-2
      3.2.1 Scanning Single-Page Document .......................... 3-3
      3.2.2 Scanning Multi-Page Document ......................... 3-5
      3.2.3 Scanning Your ID Card(s) ................................. 3-6
      3.2.4 Combining 2 or 4 pages into One Single Image ....... 3-9
   3.3 Scanning to a Computer ................................................. 3-11
      3.3.1 Verifying Your Scanner Installation ..................... 3-11
      3.3.2 A Glance of the Scanner Properties Dialog Box .... 3-15

4. Using the Scanner Properties Dialog Box ................................. 4-1
   4.1 Buttons on the Scanner Properties Dialog Box ............... 4-2
   4.2 The Image Tab ............................................................... 4-4
      4.2.1 The Image Selection Box ...................................... 4-5
      4.2.2 Other Image Options ........................................... 4-8
      4.2.3 Scanning color images ......................................... 4-20
      4.2.4 Scanning grayscale images ................................. 4-20
      4.2.5 Scanning B&W images ......................................... 4-20
      4.2.6 Editing Profiles .................................................... 4-21
   4.3 The Compression Tab ...................................................... 4-24
4.4 The Color Dropout Tab ........................................ 4-26
  4.4.1 Color Dropout Selection .................................. 4-26
  4.4.2 Other Color Dropout Options .......................... 4-28
4.5 The Paper Tab ................................................... 4-30
  4.5.1 Cropping ..................................................... 4-31
  4.5.2 Other Paper Selection .................................... 4-36
4.6 The Multi-Feed Detection Tab .............................. 4-39
4.7 The Preview Tab ................................................ 4-47
4.8 The Options Tab ............................................... 4-48
4.9 The Setting Tab ................................................ 4-57
4.10 The Imprinter Tab ............................................. 4-60
4.11 The Information Tab ......................................... 4-64

5. Scanning with the Buttons ..................................... 5-1
  5.1 Installing Button Manager V2 ............................ 5-1
  5.2 Checking the Button Configurations before Scanning ................................. 5-2
  5.3 Using Button Manager V2 with Default Function Numbers and Predefined Tasks ............... 5-4
  5.4 Scanning From One Touch of the Buttons ....... 5-8

6. Maintenance ......................................................... 6-1
  6.1 Cleaning the Glass ............................................. 6-1

7. Troubleshooting .................................................... 7-1
  7.1 Questions and Answers ....................................... 7-1
  7.2 Technical Service ............................................. 7-2

8. Specifications ....................................................... 8-1

Index ............................................................................. a
1. Introduction

Congratulations on your purchase of the intelligent flatbed scanner. With this scanner, you can either start instant scan to save the scanned images directly to your USB flash drive or connect the scanner to a computer to scan and save the images to your computer.

Before you install and operate the new scanner, please take a few minutes to read through this manual. It provides proper instructions for you to unpack, install, operate and maintain the scanner.

The following figure indicates the package contents. Please check all the items against your checklist. If you do not receive all the items, please contact your authorized local dealer immediately.
1.1 The Package Contents

1. Scanner main unit
2. Quick guide/CD
3. USB cable
4. Power adapter

Note:
1. Only use the AC adapter (WA-18H12 made by APD)/ (HEG42-120130-7L made by Hitron) included in the machine. Using other AC adapters may damage the machine and void the warranty.
2. Please unpack the packing carefully, and check the contents against the checklist. If any items are missing or damaged, please contact your dealer immediately.
1.2 Knowing the Control Panel

"To USB" Panel:
The panel contains the **File Format** and the **Image Merge** button. These buttons are designed to be used when you wish to save your scanned images to your USB flash drive.

**The File Format Button:**
Press to select your desired file format. Choice: JPEG, PDF, MPDF. The selected file format will be indicated with an illuminated LED.

- **JPEG/PDF**: Save each page of your documents as a separate JPEG or PDF file.
- **MPDF**: Combine your multi-page documents into a single PDF file.

**The Image Merge Button:**
Press to select if you wish to combine your pages to a single image. Choice: Normal, ID Scan, 2-in-1, 4-in-1.

- **Normal (1-in-1)**: Scan one page of your document in one single image.
- **ID Scan**: Combine the front and rear side of your ID card to a single image.
- **2-in-1** or **4-in-1**: Combine 2 or 4 pages of your documents into a single image.
“To PC” panel:
The panel contains a display screen and a button. The screen and button are designed to be used in the following conditions:

- **Indicates the scanner is connected to your computer:** When you connect the scanner to your computer with a USB cable, the “To PC” button will be illuminated. This indicates you can scan via the scanner’s TWAIN-compliant user interface and save your image to your computer.

- **Indicates 9 preset button settings:** Press the “To PC” button repeatedly, the display screen will show numbers from 1~9 continuously. This number indicates 9 preset button settings via the supplied Button Manager V2 software application. (Refer to chapter 6 on how to use the Button Manager V2 software application.)

- **Indicates number of pages being scanned and to be scanned:** When you scan and save your images to a USB flash drive, the number of page being scanned and waiting to be scanned will be indicated in the screen. For example, if “1” is shown steadily on, this indicates page 1 is being scanned. If “2” is flashing, this indicates you need to insert page 2.
**Operational Buttons**: The operational buttons include the Power and the Scan button which are explained in below:

| ![Power Button] | **The Power Button**: Turn on or off the scanner. |
| ![Scan Button]  | **The Scan Button**: Press to start a scan. |
2. Installation

2.1 Connecting to Power

Plug the small end of the power adaptor into the power jack of your scanner. Insert the other end to an appropriate power outlet.

![Power Adaptor Image]

2.2 Turning on the Power

Press the **Power** button on the front panel, after a few seconds, the **Power** LED will be lit. To turn off the scanner, press the **Power** button for about 3 seconds, and the **Power** LED will be off.
2.3 Installing the Scanner Driver

NOTE:
1. The Windows system CD may be required when installing on some PC’s.
2. To ensure your computer can identify the USB scanner, please install scanner driver first before connecting the scanner to your computer.
3. The scanner driver contains both TWAIN driver and WIA driver. If you are running Windows XP, or Windows Vista, after the installation of scanner driver is completed, this scanner allows you to scan via a TWAIN user interface or a WIA (Windows Image Acquisition) interface. Start your TWAIN-compatible image editing software application to select a TWAIN or WIA user interface. Or you might launch Microsoft’s Scanner and Camera Wizard to scan via a WIA user interface.

1. Place the supplied CD-ROM onto your CD-ROM drive.
2. The software installation graphic appears. If not, run “setup.exe”.

![CD Setup](image-url)
Contents on the installation graphic:

- **Install Button Manager V2**: To use the buttons on the scanner, you need to install Button Manager V2. To ensure Button Manager V2 works properly, please FIRST install Button Manager V2 before installing the scanner driver.

- **Install Scanner Driver**: To communicate with your scanner, you need to install the scanner driver. After installing the Button Manager V2 software, click **Install Scanner Driver** to install the scanner driver on your computer.

- **Install Adobe Reader**: To view the user’s manuals for the scanner and Button Manager V2, you need to use Adobe Reader to open and view the manuals in pdf file format. If you already have Adobe Reader installed on your computer, you may disregard this item.

- **View Manual**: Click “View Manual” to view or print the detailed user manual for the scanner and Button Manager V2 respectively.

3. Click **Install Button Manager V2** to install the Button Manager V2 software and then click **Install Scanner Driver** to install the scanner driver on your computer.
2.4 Connecting to a Computer

1. Connect the **square end** of the USB cable to the USB port of your scanner. Connect the **rectangle end** to the USB port of your computer.

2. The computer should detect a new USB device and prompt a **“New Hardware Found”** message.

3. In Windows XP or later, click the **Next** button to continue. When the XP certification screen appears, click **Continue Anyway** to complete the installation.

4. When the **Finish** dialog is prompted, click the **Finish** button.
2.5 Connecting to a USB Flash Disk

The product allows you to start instant scans and save the scanned images to your USB flash drive.

Simply plug your USB flash drive into the USB port of at the right side of the scanner as illustrated. In a while, the File Format button will be flashing for a few seconds and then keep steadily on to indicate the USB flash drive is connected.
3. Completing Your First Scan

3.1 Placing Your document on the Document Glass

Place your document with the text **FACE DOWN** on the glass and align the document in the bottom-right corner.
### 3.2 Starting Instant Scan and Saving Your Images to a USB Flash Disk

The scanner allows you to start instant scan with predefined scan settings and store your scanned image to a USB flash drive once a USB flash drive has been plugged into the scanner.

<table>
<thead>
<tr>
<th>The Predefined scan settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
</tr>
<tr>
<td>Image mode</td>
</tr>
<tr>
<td>File Format</td>
</tr>
<tr>
<td>Image Merge</td>
</tr>
<tr>
<td>*Auto Crop and Deskew</td>
</tr>
</tbody>
</table>

Auto Crop and Deskew function allows you to automatically crop your scanned image according to your original paper size and straighten your image if skewed.
3.2.1 Scanning Single-Page Document

If you need to scan single-page document, choose your file format to be either JPEG or PDF to save your single-page image as a separate JPEG or PDF file.

To save your document to a JPEG or PDF file format,

1. Select “JPEG” or “PDF” file format by pressing the File format button repeatedly. The LED for the selected file format will be illuminated.

2. If “Normal” is not selected, press the Image Merge button until the Normal LED is illuminated. “Normal” (1-in-1) means you do not need to merge your pages into a single image.

3. Place your single-page document on the glass with your text Face Down.

4. Press the Scan button to start scanning. During scanning, the LED of the selected file format will be flashing. When the scan is finished, the LED will keep steadily on.

5. You can find your scanned image in the folder of “DCIM” of your USB flash drive. If JPEG is selected, a subfolder of “PHOTO” will be created. If PDF is selected, a subfolder of “DOC” will be created. The prefix of the file name will be IMG for JPEG file or DOC for PDF file.
Note:

1. If JPEG file format is selected, a main folder with its sub-folder titled “DCIM\###PHOTO” will be created on your USB flash drive. These symbols, ###, represents a serial number from 100 to 999. Up to 9,999 JPEF files can be stored in each folder. Each JPEG file is named with a prefix of “IMG_” followed by a 4 digit serial number. For example, IMG_0001.jpg, and IMG_0002.jpg.

2. If PDF file format is selected, a main folder with its sub-folder titled “DCIM\###DOC” will be created on your USB flash drive. These symbols, ###, represents a serial number from 100 to 999. Up to 9,999 PDF files can be stored in each folder. Each PDF file is named with a prefix of “DOC_” and followed by a 4 digit serial number. For example, DOC_0001.PDF, DOC_0002.PDF.
3.2.2 Scanning Multi-Page Document

If you need to scan multi-page document, choose MPDF as your file format to combine all pages of your documents to a single PDF file.

To save your multi-page document to a MPDF format,

1. Select the **MPDF** file format by pressing the **File format** button repeatedly until the **MPDF** LED is illuminated.

2. Select **Normal** by pressing the **Image Merge** button repeatedly until the **Normal** LED is illuminated. “Normal” (1-in-1) means you do not wish to merge your images into a single image.

3. Place the first page of your document on the document glass with your text Face Down.

4. Press the **Scan** button to start scanning.

5. In a second, the scan is done and the **Normal** LED is blinking.

6. Open the document cover and place the 2\textsuperscript{nd} page of your document on the document glass. \textit{Note: Be sure to insert your 2\textsuperscript{nd} page in 30 seconds. Otherwise, the scanner will cancel the scan and you will get an image for one page only.}

7. Repeat step 5\textasciitilde6 if you have more pages need to be scanned. If you wish to end your scan job, simply press the “Image Merge” button again while the **Normal** LED is flashing. The **Normal** LED will then turn steadily on.

8. In a moment, a multi-page PDF file will be created as illustrated.

![An example of multi-page PDF file](image)

An example of multi-page PDF file
3.2.3 Scanning Your ID Card(s)

The “ID Card” option allows you to combine the front and rear side of your ID card into a single image.

To scan your ID card,

1. Select the your desired file format from the choice of JPEG, PDF, and MPDF by pressing the File format button repeatedly until your selected file format LED is illuminated.

   JPEG/PDF: Combine the front and rear side of your ID card into one single image and save into one single JPEG or PDF file.

   MPDF: Combine a batch of your ID cards into a single PDF file.

2. Select ID Scan by pressing the Image Merge button until the ID Scan LED is illuminated.

3. Place one side of your ID card on the document glass and align it to the home position marked by an arrow as illustrated.

4. Press the Scan button to start scanning. During scanning, “1” will be flashing in the Display screen.
5. When the scan is finished, “2” will be flashing in the Display screen. This indicates the scanner is ready to scan the other side of your ID card.

If you do not wish to end your scan, simply press any button except the Scan button. The “To PC” LED will turn steadily on.

6. Open the document cover and place the other side of the ID card on the document glass as illustrated.

7. Press the Scan button to start scanning the other side of your ID card.

**Note:**
You must press the Scan button within 30 seconds after “2” is flashing in the Display screen. If no action has been taken, the scanner will stop scanning and you will get an image containing one side of your ID card.

8. In a second, the scan is done and the front and rear sides of your ID card will be merged into one single image.

9. If you wish to scan more ID cards, repeat step #3 ~#7.
Illustration of one single JPEG/PDF file

- Nancy Yu
My ID Card

The other side of ID Card

Illustration of one single MPDF (multi-page PDF) file

- Nancy Yu
My ID Card

The other side of ID Card

- Jack Wang
My ID Card2

The other side of ID Card 2

::
::
3.2.4 Combining 2 or 4 pages into One Single Image

To combine 2 or 4 pages into one single image,

1. Select the your desired file format from the choice of JPEG, PDF, and MPDF by pressing the File format button repeatedly until your selected file format LED is illuminated.

   JPEG/PDF: Each image is saved into one single JPEG or PDF file.

   MPDF: Your multi-page documents will be saved into a single PDF file.

2. Select 2-in-1 or 4-in-1 by pressing the Image Merge button until the selected LED is illuminated.

3. Place the first page of your document on the document glass with your text Face Down.

4. Press the Scan button to begin scanning.

5. When the scanning is done, “2” will be flashing to indicate the scanner is ready to scan your next page.

6. Open the document cover to remove the current page and place the next page on the document glass.

7. Press the Scan button to begin scanning. If the 4-in-1 option is selected, you will need to repeat step #5 ~ #7 for triple times until page 4 has been scanned.

Note:
You must press the Scan button within 30 seconds after number of page is flashing in the Display screen. If no action has been taken, the scanner will stop scanning.
8. In a few seconds, the scan is done and the pages will be merged into a single image as illustrated.

**Illustration of a “2-in-1”/“4-in-1” Single JPEG/PDF File:**

![Illustration of a “2-in-1” Single JPEG/PDF File](image1)

A “2-in-1” Single JPEG/PDF File

![Illustration of a “4-in-1” Single JPEG/PDF File](image2)

A “4-in-1” Single JPEG/PDF File

**Illustration of a “2-in-1”/“4-in-1” Multi-Page PDF File:**

![Illustration of a “2-in-1” Multi-page PDF File](image3)

A “2-in-1” Multi-page PDF File

![Illustration of a “4-in-1” Multi-page PDF File](image4)

A “4-in-1” Multi-page PDF File
3.3 Scanning to a Computer

After the scanner driver is installed to your computer and the scanner is connected to your computer via a USB cable, you can start a scan via the scanner’s TWAIN user interface and save the scanned image to your computer.

If you wish to save your images to a USB flash drive while connecting your scanner to the computer and USB flash drive at the same time, simply press the button on the “To USB” panel such as the File Format button or the Image Merge button.

3.3.1 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides you a useful test program called Avision Capture Tool. With this tool, you can perform simple scans and view the captured images. In addition, it helps you complete your scan at a rated speed.

The following procedure describes how to verify your scanner installation. If the installation is not correct, please review the preceding section to check if the cable connection and scanner driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs>Avision AVxxx Scanner>Avision Capture Tool.

Note: If Avision Capture Tool does not appear on “All Programs” of your Start menu, please access from the following path:
C:\Windows\TWAIN_32\Avision\Avxxx\Avision Capture Tool.exe
The Select Scanner Model dialog box will be displayed.

2. Select your driver type and scanner model and click OK. The following Avision Capture Tool dialog box will be displayed.

3. Choose your desired file format from the File Format drop down list box. (Default is BMP, other choice includes TIFF, MTIFF, PDF, MPDF, GIF, and JPEG.) The supported file formats vary depending on your scanner model.

4. Type your desired folder name and file name in the File Path box. (Default is C:\My Scan\Image.)

**Note:**
If you do not wish to save the scanned image, deselect the Save button since default is Save Enable. In this case, the thumbnail view will be disabled. And therefore, after viewing all the scanned images, only the last one will remain on the screen.
5. Click the Setup button or choose Setup from the File menu to prompt the Scanner Properties dialog box.

6. From the Image Selection Box, choose your desired image type for your scanned image. (Default is Front B&W) If you have a duplex scanner, choose Front and Rear to scan both sides of your document.

7. Click OK to quit the Scanner Properties dialog box. (To learn more details about the Scanner Properties dialog box, please see the subsequent chapter, Using the Scanner Properties Dialog Box.)

8. Place your document face down on the document glass or face up in the auto document feeder.

9. In the Scan Validation dialog box, click the Scan button or choose Scan from the File menu.

10. The document will be scanned and displayed in the Scan Validation screen. After the scanned images have been displayed, your scanner installation verification is completed.
11. You can view the scanned image in Fit Page ( ) or Actual Size (100%) button ( ) from the Viewing toolbars at the right side.

12. Click the Close box or Quit from the File menu to exit the Scan Validation Tool.
### 3.3.2 A Glance of the Scanner Properties Dialog Box

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>Tab Options</strong></td>
<td>Choice: Image, Compression, Color Dropout, Paper, Multi-Feed Detection, Preview, Options, Settings, Information.</td>
</tr>
<tr>
<td>2. <strong>Image Selection Box</strong></td>
<td>Choose your image type and the side of document you wish to scan. Options vary based on type of scanner.</td>
</tr>
<tr>
<td>3. <strong>Brightness</strong></td>
<td>Adjust the brightness level from -100 to +100.</td>
</tr>
<tr>
<td>4. <strong>Contrast</strong></td>
<td>Adjust the contrast level from -100 to +100.</td>
</tr>
<tr>
<td>5. <strong>Resolution</strong></td>
<td>Determine the quality of the scanned image. The industry standard is 200 dpi.</td>
</tr>
<tr>
<td>6. <strong>Invert</strong></td>
<td>Reverse the color of your scanned image.</td>
</tr>
<tr>
<td>7. <strong>Scan Source</strong></td>
<td>Choice: Auto Document Feeder, Flatbed, Flatbed (Book), Automatic. (Options vary due to type of scanner)</td>
</tr>
<tr>
<td>8. <strong>Defaults</strong></td>
<td>Reset all values on the tabs to the factory default settings.</td>
</tr>
</tbody>
</table>
4. Using the Scanner Properties Dialog Box

The Scanner Properties dialog box allows you to configure the scanner’s settings. It consists of several tabbed windows each of which will be described in this chapter.

**Note:**
In this chapter, all options are available based on a duplex (double-side) scanner. If you have purchased a simplex (single-side) scanner, all options are available for single sided only.
4.1 Buttons on the Scanner Properties Dialog Box

The buttons on the Scanner Properties dialog box

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Defaults</strong></td>
<td>Click the <strong>Defaults</strong> button, the factory default settings will be shown on each tab.</td>
</tr>
<tr>
<td><strong>Scan</strong></td>
<td>After all the scan settings are satisfactory, click the <strong>Scan</strong> button to start scanning your document.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Click the <strong>Close</strong> button to leave the Scanner Properties dialog box.</td>
</tr>
</tbody>
</table>
The following table shows the default settings:

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Default settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image</strong></td>
<td>Image: Front B&amp;W</td>
</tr>
<tr>
<td></td>
<td>Binarization: Dynamic Threshold</td>
</tr>
<tr>
<td></td>
<td>Resolution: 200 dpi</td>
</tr>
<tr>
<td></td>
<td>Invert: Blank on White</td>
</tr>
<tr>
<td></td>
<td>Scan Source: Auto Document Feeder</td>
</tr>
<tr>
<td></td>
<td>Threshold: None</td>
</tr>
<tr>
<td></td>
<td>Brightness: None</td>
</tr>
<tr>
<td></td>
<td>Contrast: None</td>
</tr>
<tr>
<td><strong>Compression</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Color Dropout</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Paper</strong></td>
<td>Cropping: Automatic</td>
</tr>
<tr>
<td></td>
<td>Deskew: Yes</td>
</tr>
<tr>
<td></td>
<td>Orientation: Portrait</td>
</tr>
<tr>
<td></td>
<td>OverScan: 0.00</td>
</tr>
<tr>
<td></td>
<td>Unit: Inch</td>
</tr>
<tr>
<td><strong>Multi-Feed Detection</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>Rotation Degrees: None</td>
</tr>
<tr>
<td></td>
<td>Blank Page Removal: None</td>
</tr>
<tr>
<td></td>
<td>Edge Fill: White, 0 mm</td>
</tr>
<tr>
<td></td>
<td>Image Control Option: None</td>
</tr>
<tr>
<td><strong>Setting</strong></td>
<td>Enable Energy Saver: Enable, 15 minutes after last scan action</td>
</tr>
<tr>
<td></td>
<td>Show Scanning Progress: Yes</td>
</tr>
<tr>
<td></td>
<td>Show Warning Message: Yes</td>
</tr>
<tr>
<td></td>
<td>Save Settings after Closing: Yes</td>
</tr>
<tr>
<td><strong>Imprinter</strong></td>
<td>Digital Imprinter</td>
</tr>
</tbody>
</table>
4.2 The Image Tab

The Image tab allows you to choose the front side and (or) the rear side of your document, the type of image, and to set several basic scan settings. Note that except for the resolution, you can set individual scan settings for the front side and the rear side. For example, all settings in the Image tab, Compression tab, Color Dropout tab can be set individually for the front and the rear side. However, the settings in the Paper tab, the Option tab, and the Setting tab have to be set the same for the front and rear side.

![The Image tab dialog box](image-url)
4.2.1 The Image Selection Box

The Image Selection box includes the image type and document side option. If you wish to scan both the front side and the rear side of your color document, you can check both Front Color and Rear Color at the same time. Note the options vary based on type of scanner.

Example 1: Scanning a two-sided color document, both sides in color
Example 2: Scanning a two-sided color document, one in B&W (Drop Blue Color: Threshold: 10, Background: 79), the other in color

<table>
<thead>
<tr>
<th>Side/Image Selection</th>
<th>Front</th>
<th>Rear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Rear Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Front Gray</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Rear Gray</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Front B&amp;W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Rear B&amp;W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Front Auto Color Detection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Rear Auto Color Detection</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>Choose Color if you wish to scan a color image for your original in color.</td>
</tr>
<tr>
<td><strong>Gray</strong></td>
<td>Choose Gray image if your original contains actual shades of gray.</td>
</tr>
<tr>
<td><strong>B&amp;W</strong></td>
<td>Choose B&amp;W if your original contains only text, pencil or ink sketch.</td>
</tr>
</tbody>
</table>
Front/Rear Auto Color Detection:
Click to automatically detect and scan the front or the rear page of your color document in color image mode. If your document is in colors, the scanner will automatically scan the document into a color image. If your document is non-color, you can choose the output to be either B&W or Gray from the Non-Color Selection option. This option is useful when you have a mixture of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you cannot specify the image mode of your rear page and vice versa.

Sensitivity of Auto Color Detection
If your documents contain primarily B&W text and small amount of light or pale colors and you do not wish them to be recognized as color image to save the file size, you can reduce the sensitivity value by moving the bar to the left to let these images to be detected as B&W. The value ranges from 1 to 30. The default is 20.
4.2.2 Other Image Options

**Binarization**

This is the process of converting a grayscale or color image to a bi-tonal image. There are several different methods of performing this conversion. **Options:** Dynamic Threshold, Fixed Processing, Halftone 1~5, Error Diffusion.

**Dynamic Threshold:** Selecting Dynamic Threshold allows the scanner to dynamically evaluate each document to determine the optimal threshold value to produce the highest quality image. This is used to scan mixed document containing faint text, shaded background, or color background with a single setting. If Dynamic Threshold is selected, Threshold, Brightness, and Contrast are not available.

**Sensitivity of Dynamic Threshold**

Occasionally your scanned image may contain small dots or speckles. To remove these spots, increase the sensitivity value by moving the bar to the right. The value ranges from 1 to 30. The default is 20.
Fixed Processing: Used for black-and-white and other high contrast documents. A single level is set to determine the black-and-white transition. The threshold is programmable over the entire density range. Fixed Processing sets Contrast to 0. If Fixed Processing is selected, Contrast is not available.

Halftone: In addition to the black and white display, Halftone can present a somehow gray shade of image by using different size of dots. Halftone image looks like the picture we have seen in the newspaper. Options include Halftone 1, Halftone 2, Halftone 3, Halftone 4, Halftone 5.

Error Diffusion: Error Diffusion is a type of Halftone. Error Diffusion gives good image texture and makes text in images more readable than Halftone.
Error Diffusion Image
Threshold

Used to convert a grayscale image to a bi-tonal image. The value ranges from 0 to 255. A low threshold value produces a lighter image, and can be used to subdue backgrounds and subtle, unneeded information. A high threshold value produces a darker image, and can be used to help pick up faint images.

Adjust the threshold setting by dragging the Threshold sliding bar to the left or right to achieve the desired threshold setting.

200 dpi, Threshold: 50, Brightness: 0
200 dpi, Threshold: 100, Brightness: 0
Gray

**Document Type: Choice: Normal, Photo, Document**

Three options of document type are provided when you choose Gray as the image type for your scanned document. Choice: Normal, Photo, Document.

- **Document**: Choose Document if your original contains pure text or a mixture of text and graphic since it is an optimal setting for regular business document. When using Document, only Threshold can be adjusted.
- **Photo**: Choose Photo if your original contains photo to reproduce your photo in vivid grayscale image. When using Photo, no Threshold and Contrast can be adjusted.
- **Normal**: When using Normal, Threshold, Brightness, and Contrast can be adjusted.

**Threshold**: The value ranges from 0 to 255. The default is 230. A low threshold value produces a lighter image, and can be used to subdue backgrounds and subtle, unneeded information. A high threshold value produces a darker image, and can be used to help pick up faint images. Adjust the threshold setting by dragging the Threshold sliding bar to the left or right to achieve the desired threshold setting.
**Brightness**

Adjusts the lightness or darkness of an image. The higher the value, the brighter the image. Drag the slider to the right or left to increase or decrease the brightness. The range is from -100 to +100.

**Contrast**

Adjusts the range between the darkest and the lightest shades in the image. The higher the contrast, the bigger the different grayscale. Drag the slider to the right or left to increase or decrease the contrast. The range is from -100 to +100.
**Resolution**

A good control of the resolution results a good detail of an image that scans. The resolution is measured by dots per inch (dpi). Normally, the greater the dpi number, the higher the resolution and the image file size. Be aware that greater resolution takes more time to scan, and more disk space for the scanning image. For your information, an A4 size color image scanned at 300 dpi at True Color mode consumes approximately 25 MB of disk space. A higher resolution (usually means over 600 dpi) is only recommended when you need to scan a small area at True Color mode.

Choose a resolution value from the drop down list. The default value is 200 dpi. Available resolutions are 75, 100, 150, 200, 300, 400 and 600. Or you may choose your desired value by clicking the box in the right side of the drop down list and press the arrow key to select your desired value and then click the Add button to include it in the drop down list. **Note:** The resolution is up to 300 dpi if an imprinter or a MICR reader is installed or connected to the scanner.
Invert

Reverses the brightness and the colors in the image. The default setting is Black on a White background. Reverse mode is White on a Black background. For color images, each pixel will be changed into its complementary color at the command of Invert.

I am not worthy to have you enter my

that is God, I beg all my brothers — those w
who work manually, clerics and lay brothe
and being humble in all things; not to glorify
r to become interiorly proud because of good w
sometimes says or does in them or through t
ord: “Do not rejoice...” in the fact that the de
(10:20) Let us be firmly convinced of the fact

Black on White

I am not worthy to have you enter my

that is God, I beg all my brothers — those w
who work manually, clerics and lay brothe
and being humble in all things, not to glorify
r to become interiorly proud because of good w
sometimes says or does in them or through t
ord: “Do not rejoice...” in the fact that the de
(10:20) Let us be firmly convinced of the fact

White on Black
Scan Source Choice:
- **Auto Document Feeder**: Used to scan multiple pages.
- **Flatbed**: Used to scan a single page. For example, pages from newspaper clipping, paper with wrinkles or curls.
- **Flatbed (book)**: Used to scan several inside pages from book.
- **Automatic**: Allow the scanner automatically set its scan source. If Automatic is selected and there is document in both the auto document feeder (ADF) and the flatbed, then the scan source will be automatically set to ADF. If Automatic is selected and there is document only in flatbed, then the scan source will be set to flatbed.
- **Merge Two Sides into One Image**: If you have a sheet-fed duplex scanner with front input tray, you can scan an A3 size document with an innovative method. Thus, fold your A3 size document into A4, and then load the paper in the front tray. Choose Merge Two Sides from the Scan Source option and then the scanner is able to scan both sides of your document and merge two A4 images into one A3 image.

When you select Merge Two Sides into One Image, the Cropping or Multi-feed function will be disabled.

**Note the options vary based on type of scanner.**
Select the “Merge Vertically” option to merge the front side and the rear side of a page into one image vertically. If the “Merge Vertically” option has not been selected, the front side and the rear side of a page will be merged into one page horizontally.

Note the options vary based on type of scanner.
Color Matching

The purpose of Color Matching is getting the accurate color. This option uses the default parameters (ICC profile) to adjust the colors of the image.

Choice: None, Document, Photo
- None: Choose “None” to disable this option.
- Document: Choose “Document” if your original contains pure text or a mixture of text and graphic since it is an optimal setting for regular business document.
- Photo: Choose “Photo” if your original contains photo to reproduce your photo in vivid color image.

Normal

After Color Matching
4.2.3 Scanning color images
The following options are available for scanning color images.

- Brightness
- Contrast
- Resolution
- Invert

4.2.4 Scanning grayscale images
The following options are available for scanning gray images.

- Brightness
- Contrast
- Resolution
- Invert

4.2.5 Scanning B&W images
The following options are available for scanning B&W images.

- Binarization (Dynamic Threshold)
- Resolution
- Invert

Or

- Binarization (Fix Processing)
- Threshold
- Brightness
- Resolution
- Invert
4.2.6 Editing Profiles

The Scanner Properties dialog box allows you to change and save your frequently used scan settings into a profile. You can edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your resolution, image type, cropping method, scan size, or other scan settings.)
2. Click the Image tab and then choose “Profiles” to prompt the “Edit Your Profile” dialog box.
3. Click “Add” to enter the name of the profile and then choose “Save”.
4. The new profile will be saved and shown in the “Profiles” dropdown list box.
**To load a profile,**

1. From the Image tab dialog box, choose your favorable profile from the “Profiles” dropdown list box.

   ![Edit Your Profile dialog box](image)

2. Your favorable profile will be immediately loaded and displayed on Scanner Properties dialog box.

**To delete a profile,**

1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile dialog box.

   ![Edit Your Profile dialog box](image)

2. Choose the profile you want to delete from the dropdown list box.

3. Click “Delete”. A Confirm message “Are you sure you want to delete this profile?” is prompted.

4. Choose “Yes” to delete or “Cancel” to quit.
To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt the Edit Your Profile dialog box.

2. Choose the profile you want to rename from the dropdown list box and then click the Rename button.

3. Enter new name for the profile.

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:
The preset default profiles include Flatbed, Simplex-B&W, 200 dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If you have a simplex or a sheetfed scanner, the duplex or the flatbed option will not be available.
4.3 The Compression Tab

The Compression tab allows you to compress your scanned image and choose the level of compression. Bi-tonal images are normally compressed using CCITT standard called Group 4 (G4). Color and grayscale images are often compressed using JPEG technology. Move the JPEG Quality slider to the right or left to increase or decrease the level of compression. Note the greater the compression level, the lower image quality. Default is 50%.

Note that the compression depends on your image editing application. If your image editing application does not support the type of compression format, then either a warning message will appear or the image quality of the compressed file will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed and lent their name to a file compression standard for color and grayscale images that is widely used by scanners, and software applications. On Microsoft Windows-based systems, a file with the extension .jpg has normally been compressed using this standard.

For scanning color or gray images, the following compressions are available:
- None
- JPEG

For scanning B&W images, the following compressions are available:
- None
- G4
The Compression tab dialog box
4.4 The Color Dropout Tab

4.4.1 Color Dropout Selection

Color Dropout tab allows you to drop either of the red, blue, or green color in your scanned image. If your image contains red color watermark or background, choose the R (Red) channel then any red watermark or background will be removed. This feature is used to sharpen your text when using OCR (Optical Character Recognition) software.

The “Custom” option allows you to specify your desired color to be removed by entering its RGB (Red, Green, and Blue) value respectively.

Tolerance: Specify the allowable color range to be removed for the color you selected. Specified range: 1 ~ 100
The large the numeric value, the wider the color dropout range is.

Note that this function supports only black & white and gray images. Therefore, be sure to choose any black & white or gray image type while applying this function.
The Color Dropout dialog box
4.4.2 Other Color Dropout Options

**Advanced Processing** provides two options that can adjust your scanned image in the best optimal result.

**Filter Threshold**
This value is used to determine the color which will be dropped out. A lower value will drop more of the selected color out, while a higher value will leave more of the selected color in.

**Background Level**
The pixel which is higher than the background value will be adjusted to the lightest point. Adjust the value for both the Filter Threshold and Background Level to produce the best optimal result.

*Example, slightly adjusting the background value makes your text more clear.*

![Original Image]
Remove Blue, Threshold: 20, Background: 255

Remove Blue, Threshold: 20, Background Level: 210
4.5 The Paper Tab

The Paper tab allows you to define values relating to image output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed Detection).

The Paper tab dialog box
4.5.1 Cropping

Cropping allows you to capture a portion of the document being scanned. **Choice: Automatic, Fixed to Transport, EOP (End of Page) Detection, Automatic Multiple, Relative to Documents.**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic</strong></td>
<td>Automatic adjusts the cropping window according to different document sizes. Use this option for batches of mixed-sized documents.</td>
</tr>
<tr>
<td><strong>Fixed to Transport</strong></td>
<td>This feature allows you to define the area or zone to be imaged. Use for batches of same-sized documents. If you select this option, you can use the arrow keys to define the x and y offset values, width and length to redefine your scanned area. The Display window will show image placement as you change the values.</td>
</tr>
<tr>
<td><strong>EOP (End of Page) Detection</strong></td>
<td>This feature allows you to define the area or zone to be imaged. Use for batches of same-width but different length documents. If you select this option, you can use the arrow keys to define the x and y offset values, width and length to redefine your scanned area. The Display window will show image placement as you change the values.</td>
</tr>
</tbody>
</table>
### Automatic Multiple

This option allows you to place various sized documents such as photos, ID Cards, or business cards on the flatbed (if available) and lets you create multiple individually cropped images in one scan. Note: To correctly create multiple images, please make sure there is at least 12mm (0.5”) of space between each document.

### Relative to Document

This option allows you to crop different areas on your documents and deliver these images in B&W, Gray, or Color separately. For example, there are applications which require you to store the entire document in B&W and a part of the document in color to save storage space. This is useful for documents where a photograph or signature appears in a consistent area on the document such as resumes, and so on.

The following options are only available when **Fixed to Transport** is selected.

- **X-Offset** — the distance from the left end of the scanner to the left edge of the scanning area.
- **Y-Offset** — the position from the top end of the document to the top end of the scanning area.
- **Width** — the width of the scanning area.
- **Length** — the length of the scanning area.
- **Center**: automatically calculates the x-offset for center-fed feeding based upon document size selected.

— relocate the scan area by click the arrow key on the cross sign while retain the scan size. View the result from the Display window.
Relative to Document: (used for batches of same-sized documents)

This option allows you to crop different areas on your documents and deliver these images in B&W, Gray, or Color separately. For example, there are applications which require you to store the entire document in B&W and a part of the document in color to save storage space. This is useful for documents where a photograph or signature appears in a consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The selected scan size will be displayed in a red rectangular box. This is also the scan size of your entire document. (For example, ISO B5. If you have not chosen a scan area and leave the selection as None, then the default area will be the scanner’s maximum.)
3. Click the Preview tab to display the Preview window. A black rectangular box appears to indicate the max. scan size you have just selected.

4. Click the Preview button to view the entire image in low resolution to correctly crop your relative scan area.

5. Select image type from the Image Selection box. The selected image will appear in highlighted color. (For example, Front Color)

6. Place your cursor on the Preview window and click your left mouse button. A cross sign will appear as illustrated. Create your relative scan size diagonally by dragging the left mouse button to your preferable size. The selected area will appear in a red box as illustrated.
7. Check the B&W image from the Image Selection box to scan the entire document.
8. Click the Scan button to start scanning the document in two image types and sizes. (See the result in below.)

The entire document in B&W  The relative area in color
4.5.2 Other Paper Selection

Deskew

Use this option to automatically deskew a document.

Note: If the skew angle is too great, some of the image may be cut off.

Scan Area

Choose your desired paper size with the drop-down list box. Or you may select a custom paper size by clicking the Scan Area box and then click Add to include in the choice.

Choice: None, US Letter- 8.5” x 11”, US Legal – 8.5” x 14”, ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 10.5 x 14.8 cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, ISO B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 12.8 cm, Scanner Maximum, Long Page.

Long Page:
When you need to scan documents whose length exceeds scanner maximum, please choose Long Page. Note if Long Page is selected, the Multi-Feed Detection will not be available. Options: Unknown Length, Enter Length (Note: This option varies due to type of scanner.)
Choose “Unknown Length” if you have a batch of long page document with unknown length. Choose “Enter Length” to enter the length and width of your documents or your desired scan size on documents. This is useful when you have a batch of documents with the same scan size or a batch of same-sized documents.

**OverScan**
Overscan allows you to add a specific margin at top and bottom or right and left (Options vary based on the type of scanner) of the edge of the image. This is used to reduce possible corner clipping on the skewed images and often applied to a batch of skewed document to be scanned in the auto document feeder. Select a value between 0 and +5 mm. Note the overscan result will not be shown in the Display window and that the availability of the function varies based on type of scanner.

**Pre-Feed**
Choice: Enable, Disable. If enable is selected, you can set the amount of time the scanner starts pre-feeding your paper after your documents has been loaded into the feeder. The default is disable.

**Transport Timeout**
Set the amount of time the scanner will wait and then start auto scan after the first scan job is completed. If you have many separate documents need to be scanned at the same scan settings, this feature is especially useful. The default is 0. The value ranges from 0 to 30 seconds.
Note:
1 Within the specified timeout period, if you load your document to the feeder, the scanner starts scanning automatically.
2 If your scanner has a flatbed option and you place your paper on the flatbed, after the timeout period, you need to click the Scan button on the TWAIN user interface to start scanning.
4.6 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document that go through the auto document feeder. Multi-Feed usually occurs due to stapled documents, adhesives on documents, or electro-statically charged document. Note: The availability of the function varies based on type of scanner.
**Additional Length Detection**

Additional Length Detection allows you to define the length of document being multi-fed. This value indicates the additional length exceeding your scan area. The Display window will show the size of the document as you change the value. A value of 0 indicates no additional length detection. The Additional Length Detection is best used when scanning same-size documents in the auto document feeder.

**Intelligent Mode (Skip Multi-Feed) By Ultrasonic Detection**

Some documents which are glued with a photo or a label may easily be detected as multi-feed yet you wish to bypass these multi-feed conditions. In this case, you can use the intelligent mode to let the scanner memorizes and skips these multi-feed conditions. **Choice includes Disable, By Length(Paper/Object), By Position, By Length(Paper/Object)+Position.**

**By Length (Paper/Object):** When a multi-feed is detected for the first time, the scanner memorizes both the length of the document and the length of the object (photo or label) attached to the document. When you perform next scanning, this pattern of multi-feed will be bypassed.

**By Position:** When a multi-feed is detected for the first time, the scanner memorizes the position of the photo or label attached to the document. When you perform next scanning, this pattern of multi-feed will be bypassed.
By Length (Paper/Object)+Position: When a multi-feed is detected for the first time, the scanner memorizes the length of the document, the length and position of the object (photo or label) attached to the document. When you perform next scanning, this pattern of multi-feed will be bypassed.

To use the intelligent mode,

1. Choose your desired multi-feed detecting method to bypass by.
2. When multi-feed occurs during scanning, a multi-feed warning message appears.
3. Choose OK to skip the multi-feed condition from next scanning and close the message.
4. Open your TWAIN data source in your scanning application. The same multi-feed condition will not be recognized as multi-feed.

Note:
1. You can clear the previous multi-feed conditions by clicking the Reset button.
2. The scanner can memorize to bypass up to 25 multi-feed conditions.
3. If you uninstall your scanner driver, the previous multi-feed conditions which have been set to memorize and skip will still be valid.
Detection Area

This option allows you to specify a multi-feed detection area.

To specify a multi-feed detection area,

1. Choose **Disable** from the Intelligent Mode. The Detection Area will be enabled.

2. Choose **Inside the Range** or **Outside the Range**. The detection area will be highlighted.

3. Drag your mouse pointer on the top or the bottom of the detection area to specify your area in the display window. Or you may use the up and down arrow key of the Top and Bottom to change its size. The Top indicates the starting position of the detection range. The Bottom indicates the ending position of the detection range. Note the top value and the detection range has to be at least 1 inch.

Detection Area: Inside the Range, Box, Top: 3”, Bottom: 7”

![Detection Area Diagram](image-url)
Detection Area: Outside the Range, Box, Top: 3”, Bottom: 7”
Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by detecting paper thickness between documents. Note: The availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

- **Stop Scanning after Multi-Feed**
  
  If this is selected, the scanner will stop the feeder and display the following Warning dialog box if multi-feed is detected.

  ![Warning Dialog Box]

  **Warning**

  Multifeed is detected, please remove the rest paper from ADF.

  **OK**

  **Action:**

  1. Follow the instruction on the Warning dialog box to remove the rest pages on the feeder.
  2. Click OK to close the Warning dialog box.
  3. Scan the rest pages.
Clear the Multi-Fed Paper: Auto

If this is checked, once multi-feed is detected and scanning operation is stopped, the scanner will automatically clear the transport of the multi-fed paper. If this is not checked, once multi-feed is detected and scanning operation is stopped, you need to manually clear the transport of the multi-fed paper. Note: The availability of this option varies based on type of scanner.

- Multi-Feed Alarm
  
  If a wave file is added, the scanner will make a sound alarm if multi-feed is detected yet no Warning dialog box will be displayed.

  If “Stop Scanning after Multi-Feed” is selected, the scanner will stop the feeder.

  If “Stop Scanning after Multi-Feed” has not been selected, the scanner will continue to scan till the end of your document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow the action described in the preceding section “Stop Scanning after Multi-Feed” on the previous page to complete your job.

2. If “Stop Scanning after Multi-Feed” has not been selected, rescan the pages where multi-feed is detected.
How to add the sound alarm:

1. Click the Browse button on the right side of the speaker icon. The Open dialog box appears.
2. Choose your wave file.
3. Click the Open button. The wave file is added.

Units
Defines the primary measurement system. Inches, Millimeters, and Pixels are available.
4.7 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan) your image before final scan. This preview image lets you allocate your scan area. You can choose your scan area by the “Scan Area” drop down list box or placing your cursor on the Display window and dragging it diagonally on the Display window. Then, a red rectangle box will appear to indicate the selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”, then to select a scan area on the Preview tab is not allowed.
4.8 The Options Tab

The Options tab allows you to set following additional image processing settings.

The Option tab dialog box
Flip Side Rotation

Select “fanfold” to rotate the image of the reverse side to 180 degrees.

This is applied to double-sided document which are viewed in portrait are sometime fed into the scanner in landscape or vice versa.

**Choice: Book, Fanfold.**

If “Book” is selected, the image of the reverse side will not be rotated.

The following illustration shows the documents which should be viewed in portrait are fed into the scanner in landscape.
**Rotate Image**

Choose the rotation angle from the drop down list if you wish to rotate your scanned image.

**Choice:** None, 90°CW (clockwise), 90°CCW (counter clockwise), 180°, Auto based on contents. Auto rotate every even page.

![Original vs Rotated Images]

- **Original**
  - 123

- **Rotate 90°CW**
  - 123

- **Rotate 90°CCW**
  - 123

- **Rotate 180°**
  - 123

**Auto based on contents:** When **Auto based on contents** is selected, images can be rotated to their proper orientations based on their contents.

**Auto rotate every even page:** Automatically rotate 180° on every even page. This is especially useful when you scan the inside pages from a book. As a result, if you choose “Flatbed (book)” from the “Scan Source” option, “auto rotate every even page” will be selected as default.

**Note:** This option varies based on type of scanner.
Blank Page Removal
Check if you wish to remove the blank page and move the slider to the left or right to your desired threshold.

Edge Fill
Check White or Black if you wish to add white or black edge on the border of your scanned image. Enter the value from 0 to 5 mm. Default value is 0.

Original

Edge Fill: 5mm (Black)
Check the Mirror box if you wish to reverse the right and left side of your image.

Original

The Mirror Effect
**Punch Hole Removal**

You can remove punch holes from the output scanned image when scanning punched document. Note the availability of this feature varies depending on your scanner model.

Punch holes can not be removed when:
- Resolution is set lower than 150dpi
- The hole is near the edge of the document
- The holes are not aligned along the edge of the document
- Punch Hole Removal is available only when “Auto Crop” is enabled. If either “Fixed to Transport”, “EOP (End of Page) Detection”, “Automatic Multiple”, “Relative to Documents” is selected from the Cropping option on the Paper tab, the Punch Hole Removal option will be disabled.
Despeckle

Occasionally small dots or specks appear in the background of a scanned image. Remove unwanted speckles provides a cleaner image for OCR (Optical Character Recognition) processing, and also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to remove by specifying its number (size) and radius (range). The measuring unit is pixel. The higher the number, the more speckles will be removed.

Before Despeckle
(noise number: 0, noise radius: 1)

A plague on thee! Hast thou never an eye in thy head? Canst not hear?
—The First Part of King Henry the Fourth: 2.1.26–27

A carrier to Gadshill, the host of a tavern.

After Despeckle
(noise number: 22, noise radius: 10)
**Note:**

- The function is currently available for Black and White image only.
- To scan at rated speed, it is recommended to set the noise radius up to 10 pixels.
Background Setting

This option allows you to set your scan background. **Choice: White Background, Black Background.**

Note: For a sheet-fed scanner with an auto document feeder, this option is currently available only in the “Auto crop” mode. For a scanner with a flatbed platen, this option is available either in the “Auto crop” or the “Fixed to Transport” mode.

For details on choosing the “Auto crop” or the “Fixed to Transport” mode, please refer to section 4.5.1, Cropping.
4.9 The Setting Tab

The Setting tab allows you to set the following settings:

The Setting tab dialog box

<table>
<thead>
<tr>
<th>Energy Saving Control</th>
<th>Check the Enable Energy Saver box and move the slider to set the amount of time to start the energy saver after your last action. The range is from 1 to 240 minutes. The default value is 15 minutes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Power Off</td>
<td>Check the Enable Power Off box and move the slider to set the amount of time to automatically turn off the scanner after your last action. The range is from 1 to 480 minutes. The default is 240 minutes (4 hours). Note the value of “Power Off” has to be greater than or equal to the value of “Energy Saving”.</td>
</tr>
</tbody>
</table>
Cache | Mode: None, Page Number, Memory Size.
This option allows you to assign a specified memory size from the available RAM to process the image data. By specifying a smaller memory size, you can free more memory for other applications you are running. By specifying a larger memory size, you can have more memory to process the image data especially when you have a large amount of documents needed to be scanned.

You can also specify your memory size by the page number. For your information, an A4 color document scanning at 300 dpi consumes approximates 24MB.

Image Count
When the selected cache mode is “none”, the image count option allows you to assign number of pages you need to scan. For example, if you wish to scan the first two pages, simply move the page slider to 2, and the scan action will be stopped when the scanning of the first two pages have been completed.

Barcode Detection
Check this option to enable detecting and recognizing barcode in your document. After the detecting process, an avbarcode.ini file will be generated and stored in your system drive, for example, Windows\avbarcode.ini. Note: The availability of this feature varies based on type of scanner.
<table>
<thead>
<tr>
<th><strong>Show Scanning Progress</strong></th>
<th>Check and the scanning progress bar will be shown during scanning.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Warning Message</strong></td>
<td>Check to show the warning messages such as “ADF pad count exceeds 50,000 scans (the number varies based on type of scanner). Please replace the ADF pad and reset the pad count.”</td>
</tr>
<tr>
<td><strong>Save Settings after Closing</strong></td>
<td>Check to save your scanner properties settings after leaving the dialog box. Next time when you open the Scanner Properties dialog box, the previously saved settings will be shown.</td>
</tr>
</tbody>
</table>
4.10 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters, date, time, document count and custom message on your scanned image if digital imprinter is selected or at the back of your document if external imprinter is selected.

**Choice: External Imprinter, Digital Imprinter.** If you have installed an external imprinter, choose external imprinter. If you do not have an imprinter, choose digital imprinter. Note External Imprinter provides a vertical and rear-side print capability while digital printer provides a horizontal and front-side print capability.
## Contents

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print All</strong></td>
<td>Check <strong>Print All</strong> to automatically print the text at all pages of your documents. Uncheck <strong>Print All</strong> to print the text for the first page of your documents only.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>Enter your custom text to be included in your print string.</td>
</tr>
<tr>
<td><strong>Counter</strong></td>
<td>Show the document count for the scan session. This value is increased sequentially by the scanner.</td>
</tr>
</tbody>
</table>

### Date/Time

Choose if you wish to include the date and time in your print string. Format: YYYYMMDDHHSS For example, 20090402170645-check0001 indicates year, month, date, hour, seconds, your custom text and the counter.

### Custom Font

Choose your desired font. **Choice: Normal, Fixed Width**

**Fixed Width** (Mono spaced) fonts have a fixed character spacing. So each character occupies the same width.

### Advanced

<table>
<thead>
<tr>
<th>Font Attributes</th>
<th>Choose your font attributes. <strong>Choice:</strong> Normal, Underline, Double, and Bold.</th>
</tr>
</thead>
</table>

Choose your string orientation. **Choice:** Normal, Rotated, Vertical, Vertical Inversion, 90 degrees CW, 90 degrees CCW

<table>
<thead>
<tr>
<th>String Orientation</th>
<th>2010abc</th>
<th>2010abc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
<tr>
<td>Rotated</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
<tr>
<td>Vertical</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
<tr>
<td>Vertical Inversion</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
<tr>
<td>90 degrees CW</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
<tr>
<td>90 degrees CCW</td>
<td>2010abc</td>
<td>2010abc</td>
</tr>
</tbody>
</table>

If you check the digital imprinter to stamp text on your scanned image, the illustration of normal and rotated string is shown below:

<table>
<thead>
<tr>
<th>2010abc</th>
<th>2010abc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Rotated</td>
</tr>
<tr>
<td>Print Position</td>
<td>Choose the position you wish to print your string. Move the slider to the right to increase the value or to the left to decrease the value. Range: 0~355mm, default: 0 mm The value indicates the height from the bottom of your paper to the last letter of your string. This option is available only if an external imprinter is installed.</td>
</tr>
</tbody>
</table>

**Print Position (for digital imprinter)**
Choose the position of your printed string. **Choice: Top, Middle, Bottom, Custom.** If Custom is selected, enter the X and Y offset value to specify the position.
4.11 The Information Tab

The Information tab displays the following system and scanner information.

![Scanner Properties dialog box](image)

The Information tab dialog box

The "Report" button:

If you encounter any error message while using the scanner, click the Report button. A report.txt file (C:\AVxxx, xxx: scanner model) will be generated. Please send this file to the nearest service center for trouble shooting.
The “Reset Pad Count” button:

After scanning approximately 50,000 pages (the number varies based on type of scanner) through the Auto Document Feeder (ADF), the ADF pad may be worn out and you may experience problems with document feeding. In this case, it is highly recommended to replace the ADF pad with a new one. (Please refer to the manual for proper replacing procedure.) For ordering the ADF pad, please consult your nearest dealer. After replacing the ADF pad, click the “Reset Pad Count” button to reset the pad count.

The “Reset Roller Count” button:

After scanning approximately 200,000 pages (the number varies based on type of scanner) through the ADF, the ADF roller may be worn out and you may experience problems with document feeding. In this case, it is highly recommended to replace the ADF roller with a new one. (Note the replacement of the ADF roller has to be performed only by authorized service center. Therefore, please return your scanner for roller replacement.) After replacing the ADF roller, click the “Reset Roller Count” button to reset the roller count.

Note:
The lifetime and the replacing procedure vary based on type of scanner.
5. Scanning with the Buttons

Display Screen & Function Selector are used to select and show a button number preset via the supplied Button Manager V2 software.

5.1 Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your document and then link the scanned image to your designated software application. All this can be done by a simple touch of the button on the scanner. Yet, before you scan, it is recommended to check the button configurations first to ensure a proper file format and a destination application.
5.2 Checking the Button Configurations before Scanning

1. Button Manager V2 runs from the system tray. After Button Manager V2 and the scanner driver are properly installed, Button Manager V2 is started and the Button icon will be displayed on the system tray at the bottom right corner of your computer screen.

2. Left-click the Button Manager V2 icon to prompt the following Button Panel.

![Button Panel Diagram]

This indicates the scanner model

The Function Icon
(The number of function icons vary based on type of scanner.)

The Button Panel
3. The Button Panel shows the first five scanning buttons. Right-click the button (function) you wish to check. The Button Properties window appears.

If you wish to change the setting, use this window to reset the setting for the file format, destination application, or other scan settings.

4. Click the OK button to leave the window.
5.3 Using Button Manager V2 with Default Function Numbers and Predefined Tasks

The scanner is shipped with nine preconfigured button settings for your frequently tasks such as scan-to-folder, scan-to-email, or scan-to-printer. The following table shows these factory default settings. You can change any of these settings.

<table>
<thead>
<tr>
<th>Button Number</th>
<th>Name</th>
<th>Destination/Application</th>
<th>Preset Scan Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>iScan (Image)</td>
<td>Select this button when you want to scan a document and insert a scanned image to your application which is already launched</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>2</td>
<td>iScan (OCR)</td>
<td>Select this button when you want scan a document and to insert the editable text after OCR(Optical Character Recognition) to your text editor which is already opened.</td>
<td>Auto Color Detection, 300 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>3</td>
<td>Scan To App</td>
<td>Select this button when you want to scan a document and send the image to your designated application (default: MS Paint)</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>E-mail</td>
<td>Select this button when you want to scan a document and send the image from your default e-mail software to an e-mail recipient as an attachment.</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>5</td>
<td>Printer</td>
<td>Select this button when you want to scan a document and print it from your default printer</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>6</td>
<td>Shared Folder</td>
<td>Select this button when you want to scan a document and save the image to a shared folder in the network.</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>#</td>
<td>Server</td>
<td>Description</td>
<td>Setting</td>
</tr>
<tr>
<td>---</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>7</td>
<td>FTP</td>
<td>Select this button when you want to scan a document and save the image to a network file server such as FTP.</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>8</td>
<td>SharePoint</td>
<td>Select this button when you want to scan a document and save the image to a network file server such as Microsoft SharePoint server.</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
<tr>
<td>9</td>
<td>Google Docs</td>
<td>Select this button when you want to scan a document and save the image to a network file server such as Google Docs.</td>
<td>Auto Color Detection, 200 dpi, Simplex, JPEG, Auto Crop</td>
</tr>
</tbody>
</table>
Note:

- To accurately use the default settings, you need to setup your computer in an internet environment and install the necessary software applications such as E-mail software, or printer before installing Button Manager V2.
- To send your scanned images to a network server such as FTP, Microsoft SharePoint, or Google Docs, make sure you have the previledge to access the network server. For example you need to create a login name and password first.
- **Microsoft .NET Framework:** To accurately send your scanned images to a network server, Microsoft .NET Framework 2.0 or higher is required. (Check the program and the version by choosing Start>Control Panel>Add or Remove Programs. A list of programs will be displayed. If you have installed Microsoft .NET Framework, the program and the version will be shown in the list.).
- **Google Docs:** Google provides a document hosting, management and editing service called Google Docs to every user that has signed up for an account at Google web site (http://docs.google.com).
- **Microsoft SharePoint:** Microsoft SharePoint is a collaboration and document library tool developed by Microsoft for file sharing and web publishing. You may need to contact your system administrator to get the correct URL for the SharePoint server. Your system administrator will also give you access to the SharePoint and a valid user login and password.
5.4 Scanning From One Touch of the Buttons

1. Adjust the paper guide for the width of paper and load the document with their tops into the automatic document feeder.
2. Check the number on LCD screen on the scanner to ensure if you are selecting the proper scan settings and destination application. (For example, if you wish to scan with button #3 “Scan to App” which opens Microsoft Paint and displays the scanned image in the window of Microsoft Paint, the LCD screen should show #3).
3. Press the **Scan** button on the scanner.
4. After the scanning is finished, the Microsoft Paint software will be launched and the scanned image appears in the main window of Microsoft Paint as below.

![Image of Microsoft Paint window with scanned image]

**Note:**

1. For details information on how to use the Button Manager V2, please refer to the user’s manual in the supplied CD.
2. You may also use Button Manager V2 on your desktop by starting Button Manager V2 from All Programs or double clicking the Avision Scanner Utility from the Control Panel.
6. Maintenance

6.1 Cleaning the Glass

The product is designed to be maintenance-free. However, it still needs to be cleaned occasionally to ensure optimum image quality and performance.

The procedures

1. Wet a clean and lint-free cloth with isopropyl alcohol. (95%)
2. Open the document cover as shown. Wipe the document glass.
3. Close the document cover. Your scanner is now ready to use.
7. Troubleshooting

7.1 Questions and Answers

<table>
<thead>
<tr>
<th>Question:</th>
<th>Why does my scanned image always come out too dark?</th>
</tr>
</thead>
</table>
| Answer:   | 1) Please adjust the screen settings to SRGB.  
           | 2) Please adjust the brightness settings on the screen from application software. |

<table>
<thead>
<tr>
<th>Question:</th>
<th>When I choose optical resolution to be 600 dpi, the &quot;auto crop&quot; and &quot;deskew&quot; functions will be disabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer:</td>
<td>Since to perform auto crop and deskew consumes great deal of system memory, it is suggested if you wish to perform &quot;auto crop&quot; and &quot;deskew&quot; functions, please choose your optical resolution to be smaller than 600 dpi to prevent a error message.</td>
</tr>
</tbody>
</table>
7.2 Technical Service

Before contact Avision, please prepare the following information:

- Scanner serial & revision number (located on the bottom of the scanner);
- Hardware configuration (e.g., your host CPU type, RAM size, free disk space, display card, interface card);
- The name and version of your scanning software application;
- The version of your scanner driver.

Please call us at:

**Headquarter**
Avision Inc.
No. 20, Creation Road I, Science-Based Industrial Park, Hsinchu 300, Taiwan, ROC
TEL: +886 (3) 578-2388
FAX: +886 (3) 577-7017
E-MAIL: service@avision.com.tw
Web Site: http://www.avision.com.tw

**US and Canada Area**
Avision Labs, Inc.
6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369
FAX: +1 (510) 739-6060
E-MAIL: support@avision-labs.com
Web Site: http://www.avision.com
China Area
Hongcai Technology Limited
7A,No.1010,kaixuan Road,Shanghai 200052 P.R.C.
TEL :+86-21-62816680
FAX :+86-21-62818856
E-MAIL :sales@avision.net.cn
Web Site:http://www.avision.com.cn

Europe Area
Avision Europe GmbH
Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40
FAX: +49-2151-56981-42
E-MAIL: info@avision-europe.com
Web Site: http://www.avision.de
8. Specifications

All specifications are subject to change without notice.

- **Model Number**: BF-1008S
- **Scanner Type**: Flatbed
- **Technology**: CIS (Contact Image Sensor)
- **Light Source**: LED
- **Scanning Mode**: Color/Grey/Black & White
- **Optical Resolution**: 1200 dpi
- **Maximum Scanning Size**: 8.5” x 11.7”
- **Interface**: High Speed USB 2.0
- **Power Requirement**: 12Vdc, 1.25A
- **Power Consumption**: < 10 watts (operation)
  < 6 watts (power saving)
- **Humidity**: 10% to 85% RH
- **Operation Temperature**: 10°C to 35°C
- **Dimension**: 440 x 268 x 45 mm (WxDxH)
- **Weight**: 1.7 kgs
Index

A

Additional Length Detection, 4-39

Auto Color Detection
  sensitivity, 4-7

B

B&W, 4-6

Background Level, 4-27
  Background Setting, 4-54
  Barcode, 4-56

Binarization
  Dynamic Threshold, Fixed Processing, 4-8

Blank Page Removal, 4-50

Brightness, 4-14
  Button Panel, 5-2
  Button Properties window, 5-3

C

Cache
  None, Page Number, Memory Size, 4-56
  Color, 4-6
  Color Dropout
    Remove Red, Remove Green, Remove Blue, Custom, 4-25

Color Matching, 4-18

Contrast, 4-14

Energy Saving, 4-55

F

Filter Threshold, 4-27

Fixed Width, 4-59

Flip Side Rotation, 4-48

Font Attributes
  Normal, Underline, Double, Bold, 4-59

G

G4, 4-23

Gray, 4-6, 4-12
I
Intelligent Mode (Skip Multi-feeds)
Disable, By Length(Paper/Object), By Position, By Length(Paper/Object)+Position, 4-39

Invert, 4-16

J
JPEG, 4-23

M
Mirror, 4-51
Multi-Feed Detection, 4-38

N
network server
Shared Folder, FTP, Microsoft SharePoint, Google Docs, 5-7

O
OverScan, 4-36

P
Print All, 4-59
Print Position, 4-61

R
Reset Pad Count, 4-63
Reset Roller Count, 4-63
Resolution, 4-15
Rotate Image, 4-49

S
Scan Area, 4-35
String Orientation
Normal, Rotated, Vertical, Vertical Inversion, 90 deg CW, 90 deg CCW, 4-60

T
Transport Timeout, 4-36

U
Ultrasonic Detection, 4-43